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Workshop Objectives

Definition and functions of spreadsheets
Basic components of Excel

Creating workbooks and worksheets
Navigation

Data entry

Formatting (data and cells)

Creating simple formulas

Printing

Creating graphs and charts
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Definition and Functions

o An electronic ledger developed to
ease time-consuming numeric
calculations like budgets, grades,
etc.

o Functions as a simple database,
allowing easy manipulation of data
to include search and sort, etc.
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Basic Terms and Features
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Basic Terms and Features

o Standard Toolbar

o The Standard toolbar, located beneath the menu bar, has
buttons for commonly performed tasks like adding a
column of numbers, printing, sorting, and other
operations. Excel let's you customize the toolbar or even
display multiple toolbars at the same time. The Standard
Excel XP toolbar appears in the figure below.
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Basic Terms and Features

o Formatting toolbar

The Formatting toolbar, located beneath the Standard
toolbar bar, has buttons for various formatting operations
like changing text size or style, formatting numbers and
placing borders around cells.
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Basic Terms and Features

o Formula bar

The formula bar is located beneath the toolbar at the top
of the Excel worksheet. Use the formula bar to enter and
edit worksheet data. The contents of the active cell always
appear in the formula bar. When you click the mouse in
the formula bar, an X and a check mark appear. You can
click the check icon to confirm and completes editing, or
the X to abandon editing.
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Creating a New Workbook

o File menu, choose New

Type a question For help

Task Pane will open B ER
Hj New Workbook * X
(0] T00|bal’ Open a workbook
(= Workbooks...,

ew
Blank Workbook

New from existing workbook
@ Choose workbook, ..

Mew from template
General Templates, ..
_Eil Templates on my Web Sites, ..

Jﬂ @ Templates on Microsaft,com
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Creating/Adding a Worksheet

o Select Insert, then Worksheet

o Go to a worksheet tab, right click on
your mouse, choose Insert, if
worksheet icon is highlighted in
blue, hit OK
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Naming/Renaming a Worksheet

o Move curser to the worksheet tab you
want to name

Right click on your mouse

Choose Rename

The worksheet tab will be highlighted
Hit the delete key to erase current name
Type in the new name for the worksheet

Select File, Save, or Save As or use
toolbar icon to save changes
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Naming a New Workbook

o Go to File, then Save, or toolbar
icon of a diskette

o Delete highlighted name in the File
Name: box

o Type in desired file name and click
Save to complete the save
procedure

Practice #1

o Create a new workbook

o Name the workbook “Fall _2006”
o Create and label four worksheets
o Name worksheet #1 “Dec 06”

o Name worksheet #2 “Sep 06”

o Name worksheet #3 “Oct 06”

o Name worksheet #4 “Nov 06”
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Moving/Copying a Worksheet

Go to the worksheet tab you wish to copy
Right click on your mouse
Select Move or Copy

Check the box for Copy if you wish to
retain the original worksheet where it is
currently located

o To book (use drop down box to select
desired workbook)

o Before Sheet will place your worksheet
in front of the one highlighted in the box

O O O O
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Practice #2

o Open a new workbook “Spring_2006”

o Go back to workbook “Fall_2006” and
move the worksheets so that the sheets
are in month order (Sept, Oct, Nov, Dec)

o Add four more worksheets to the
“Fall_2006” workbook. Name the
worksheets Jan 06, Feb 06, Mar 06, April
06, May 06

o Move these new worksheets into the
“Spring_2006" workbook
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Navigation

Refer to the table below for additional information on using
the keyboard to navigate a worksheet.

To move

Press this key

One cell left

Left Arrow

One cell right

Right Arrow

One cell up

Up Arrow

One cell down

Down Arrow

To top of worksheet (cell A1)

Control Home

To last cell containing data

Control End

To end of data in a column

Control Down Arrow

To beginning of data in a column

Control Up Arrow

To end of data in a row

Control Right Arrow

To beginning of data in a row

Control Left Arrow
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Data Entry

o Entering Data
@ Label (text)
@ Values (numbers and

o Editing Data

dates)

@ Select the cell and retype entry (works well with

numbers)

@ Use the formula bar (works well with text)

o Clearing Cell Contents

® Choose Clear from the Edit menu

@ Press the Delete key
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Data Entry

o Undoing Mistakes
@ Use the Undo command on the Edit menu
# Use the Undo tool to correct the mistake

o Copy Data

@ Copy selected data from one cell to another
with the Copy and Paste commands

@ Use the Drag and Drop procedure

o Move Data
& Use the Cut and Paste commands
@ Use the Drag and Drop procedure
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Practice #3

Type in the following data:

Equipment Travel Personnel Total
Dept1 $1,000.00 $ 15,000.05 $36,400.00
Dept2  $4,800.00 $ 6,659.98 $20,005.00
Dept 3 $ 7,230.98 $ 34,647.23 $56,122.47

Total
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Formatting Columns/Rows

o Select column(s) you wish to change, go to Format
menu, choose Column then Width, then type a number
(represents the no. of characters that will fit in the cell.
Default is Helvetica 10pt) or choose Best Fit to
automatically widen the largest label

o By dragging column borders

o Repeat same steps to format rows. Select Row instead of
column

ABC.XLS
C D E
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Formatting Data

Changing formats using the toolbar

Excel has a Formatting toolbar to simplify basic formatting
tasks. The Formatting toolbar appears in the figure below.
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Formatting Cells (Font)

Format Cells

Mumber I Alignment Border | Patterns I Protectionl

Fonit: Fant skyle; Size:
Inrial IReguIar IID

Bl albertus MT Lt g a

9
Antique Clive Roman gslg el LI . LI
Underline: Color:
INone j I Aukomatic j ¥ Mormal font
fFeck reviey

[ strikethrough

[~ Superscript . AaBbCcYyZz

[~ Subscript

This is a TrueType font, The same Font will be used on bath your printer
and your screen.

QK I Cancel
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Formatting Cells (Numbers)

Farmat Cells

Mumber |P.Iignment | Fonk I Border | Patterns | Protectionl
Cateqory: ’—Samplc |

Decimal places: |2 5‘

Currency Formats are used for general monetary values. Use Accounting
formats ko align decimal points in a calumn.

oK I Cancel
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Formatting Cell (Borders/Shading)

o Format Dialog box
o Toolbar

Sy .
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Practice #4

Format your data to resemble the example below:

Commodities Equipment Personnel Total
Dept. 1 $ 1,000.00 $ 15,000.05 $ 36,400.00
Dept. 2 $ 4,800.00 $ 6,659.98 $ 20,005.00
Dept.3 $ 7,230.98 $ 34,647.23 $ 56,122.47
Total
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Building a Formula

o Select the cell in which you want
the results to appear

o Go to Insert Function
o The AutoSum screen will appear

o Move the highlighted bar to the
desired function (Sum, If, Average,
etc.) or category
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Formula (AutoSum)

Insert Function

Search for a Function:

Type a brief description of what you want ta do and then Go |

click Go

Or select & category: |Most Recently Used j

Select a funckion:

HYPERLIME
COUNT

SUM{number1,numberz,...)
Adds all the numbers in a range of cells.

Help on this Function oK I Cancel
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Copying Formula

@ Position the mouse on the Fill Handle at the bottom, right corner of
the cell

@When the mouse changes into a crosshair, press and drag over the
cells you want included in your formula

@& Watch the cells show up in the function argument box. Hit OK
when all values have been selected.

Function Arguments

LIr
F Number1 || :k_] =

Murmber2 | j‘_] =

Adds all the numbers in a range of cells,

MNumber1: number1,numberZ,... are 1 to 30 numbers ko sum. Logical values and text
are ignored in cells, included if typed as arguments.

Formula result =

Help on this Function Ok I Cancel

Practice #5

o Use the AutoSum function to add
up the totals for the departments
and the budget categories

o Bold and increase the size of the
fonts for the total figures

o Save changes
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Printing

o Adjusting page set up
@ Change page margins
@ Change page orientations

@ & Portrait " Landscape Print Preview
 Adpsttor  [100 =5 % normal size
Cogkto: [ 3 pagelsiwideby [1 ot
Paper sige:  |Letter81/2x 11in =]
Prink qualky:  [600 dpi =
Figst page number: Atk
[ ] o |

Printing (contd.)

o A header is text that prints at the top of each page. A
footer is text that prints at the bottom of each page

o The header and footer are divided into three sections (left,
center and right). Press <Tab> or <Shift Tab> to move
from section of the header or footer to another.

Paga Setup
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Printing (contd.)

o Print Preview EJ.,

® The Print Preview screen also has several buttons at
the top of the screen for making adjustments. For
example, the Setup button opens the Page Setup
dialog box and the Margins button lets you change
page margin and column widths to fit more

information on one page.

@ If you are satisfied with how the output appears in
the Print Preview screen, the Print button lets you

send your output directly to the printer.
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Printing (contd.)

oGo to File menu, Print option

oToolbar icon %

Mame: | Lexmark optra 5

Status: Ide

Type: Lesxmark. Opkra 5 1855 plus P53
Where: IP_178.83.134.245

Comment:  Created by Lexmark Custom Instal, Jun

rPrink range - Copies- 1
= al Mumber of copies: I.-E
" Page(s) Erom: Hwe: [

rPrint what col
" Selection " Enire workbook. @ @ o
(% Actiye sheet{s)

p«wb!' III Cancel
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Making a Chart or Graph

o Highlight the portion of the
worksheet that you want to depict
graphically

o Select the Chart Wizard icon E

o Go through Step 1-4

o Charts/graphs can be printed

independently of worksheets by
selecting the chart/graph
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Chart Wizard

o To create a chart in Microsoft Excel, select
the data you wish to graph and choose
Chart... from the Insert menu, or click
on the Chart Wizard () button on the
standard toolbar.

o Step 1
@ Select Standard or Custom Chart Type;
select Chart sub-type

@ The Press and hold to view sample button
will show you a tiny preview of your data's
chart
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Chart Wizard (Step 1)

Chart Wizard - Step 1 of 4 - Chart Type EHE

Standard Types | Custom Types |

Chart sub-type:

M
FACIE
£l

lustered Column, Compares values across
ategaries,

Press and hald ko view sample |

EI Cancel | < Back | Mext = I Finish |
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Chart Wizard (contd.)

Step 2:

@ Step two allows you to choose the Chart's Source
Data. This is the data you want to graph. Here we
can also see a sample of the chart. If Excel is
charting the wrong data, simply click on the
collapse button ("go out and get it" button) () and
choose the data you wish to graph, once it is
selected, press enter to return to this window.

@ From this Data Range tab you can also change the
Series in: option, such that instead of charting the
data by column, it will chart the data by row.
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ChartWizard (Step 2)

Data Range | Seties | Data Range

Series

Chart Wizard - S5tep 2 of 4 - Chart Source Data JEd E3 ([l Chart Wizard - Step 2 of 4 - Chart Source Data

as00

311

aso0

kit

2000

2000

[]

00 1500
1000 1000
500 —|—'7 s00

0 ‘ | 0

Socks

Blouzes Hatz

Dat. Series
ata range:
- ! = Mame: ='Sales by Year'l§B1 1]
Series in: © Rows
& Calumns 7 i
o values: ='Sales by Vear'l$E$2 SE$E q‘:]
Add Remave
Category (¥) axis |labels: |=‘Sales by Year'l§agz:$age js_]
@ | Cancel < Back | Mext = I Einish | @i Cancel | < Back | Next = I Einish I
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Chart Wizard (contd.)

o Step 3:
& Each part of the Chart can be changed with in
the options. After the chart is created you will
still be able to change these options

@ The Chart title: goes across the top of the

graph, the Category (X) axis: goes under our

X-axis labels (shown here as Pants, Shoes,
Socks...), the Value (Y) axis: will be the label
for the vertical labels (shown here as 2500,
2000, 1500..)

@& These titles will not show up on your sample
chart until you have left that text box. (Click
somewhere else in the window)
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Chart Wizard (Step 3)

Chart Wizard - Step 3 of 4 - Chart Dptions

Titles | Axes I Gridlines I Legend I Data Labels I Diata Table I

Chart title:
|Chart Title Chart Title
Category (=) axis: 2500
Ix-axis 2000 ]
Yalue () axis: & 1500
I
- i L
Iy axis .
Second category (%) axis: s
| . ||
Second value (‘f') axis: Pants  Zhoez  Socks Blouses  Hats
I I-3aXis
Cancel < Back Mexk = Finish
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Chart Wizard (contd.)

o Step 4:

& This final step is to determine the location of
your chart. You can place it as a new sheet,
which will insert a new worksheet into your
workbook and completely fill the tab with the
chart such that when you print you will only

get the chart

@ If you place the graph as an object in an
existing worksheet, it will size to fit within the
window trying not to cover existing data. With
this option when you print you will get the data
on that sheet and the graph
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Chart Wizard (Step 4)

Wizard - Step 4 of 4 - Chart Location

|_|_I_ " As new sheet: IChartl

1 & as object in: L
Alml | = abject in j
El | Cancel | < Back | Mext = | Einish I

Please do not duplicate without permission from the LEC.

Chart Wizard (contd.)

A [ B [ ¢ [ D [ E J F [T & [ H T 1T T 3 T kK [ L
[ 1 |item FEEE
| 2 Pants 1836
| 3 Shoes 1841
| 4 |Socks 591 [ _|
| 5 Blouses 2197
| B [Hats 297
7|
N
9
[ 10| $558
1]
|12 2500
|13 S
| 14] 2000
15| ]
|16 | 1500
7]
|18 1000
KEl
|20 500 =
i e
[22] 0 ' ' ' '
123 Parnts Shoes Socks Blouses Hats
| 24|
5]
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Practice #6

o Develop a pie chart to depict the
expenditures for Dept 1

o Paste pie chart in worksheet Oct 06

o Paste the pie chart in a separate
document
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Microsoft Excel Help

-1

# Microsoft Excel Hel
Contents  Answer Wizard |1ndex | P

What's New

L

earn sbout the new Features in
Wihat would you ke to do? Microsoft Excel and in al

m Serarsareiins Microsoft Offic programs.
oo usstion fiers and then Microsaft Office Web Site N
' Wisit the Microsoft Office Web i
site an the Web to find e

addiional products, services

and assistance.

select topic to display: Getting Help P "
— Learn about the different F‘.
resources available to get help 3
while you work,

Help Topics

= iccessibiity for peopls with
disabiliies

= Keyboard shorteuts

* Importing data

% * Wb queries

® Workshest and workbook protection
* PivatTable reports

Web Pages
Click a irk ko visk the World Wide Web,

= Microsoft Press

*  Microsoft Product Suppork Services

Search on eb
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